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1 Copyright

Copyright 2009 Flachmann und Heggelbacher

All rights reserved. No parts of this work may be reproduced in any form or by any means -
graphic, electronic, or mechanical, including photocopying, recording, taping, or information
storage and retrieval systems - without the written permission of the publisher.

Trademarks

Products that are referred to in this document may be either trademarks and/or registered
trademarks of the respective owners. The publisher and the author make no claim to these
trademarks.

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in
the United States and/or other countries.

Disclaimer

While every precaution has been taken in the preparation of this document, the publisher and the
author assume no responsibility for errors or omissions, or for damages resulting from the use of
information contained in this document or from the use of programs and source code that may
accompany it. In no event shall the publisher and the author be liable for any loss of profit or any
other commercial damage caused or alleged to have been caused directly or indirectly by this
document.

Contact

E-Mail Support: docklight@fuh-edv.de

Flachmann und Heggelbacher
Waldkirchbogen 29

D-82061 Neuried

Germany
http://www.fuh-edv.de
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2.2

Introduction

Docklight - Overview

Docklight is a testing, analysis and simulation tool for serial communication protocols (RS232,
RS485/422 and others). It allows you to monitor communications between two serial devices or to
test the serial communication of a single device. Docklight is easy to use and works on almost any
standard PC running Windows Vista, Windows XP, Windows 2000 or Windows NT.

Docklight's key functions include

¢ simulating serial protocols - Docklight can send out user-defined sequences according to the
protocol used and it can react to incoming sequences. This makes it possible to simulate the
behavior of a serial communication device, which is particularly useful for generating test
conditions that are hard to reproduce with the original device (e.g. problem conditions).

¢ logging RS232 data - All serial communication data can be logged using two different file
formats. Use plain text format for fast logging and storing huge amounts of data. An HTML file
format, with styled text, lets you easily distinguish between incoming and outgoing data or
additional information. Docklight can also log any binary data stream including ASCII 0 <NUL>
bytes and other control characters.

o detecting specific data sequences - In many test cases you will need to check for a specific
sequence within the RS232 data that indicates a problem condition. Docklight manages a list of
such data sequences for you and is able to perform user-defined actions after detecting a
sequence, e.g. taking a snapshot of all communication data before and after the error message
was received.

¢ responding to incoming data - Docklight lets you specify user-defined answers to the different
communication sequences received. This allows you to build a basic simulator for your serial
device within a few minutes. It can also help you to trace a certain error by sending out a
diagnostics command after receiving the error message.

Docklight will work with the COM communication ports provided by your operating system.
Physically, these ports will be RS232 SUB D9 interfaces in many cases. However, it is also
possible to use Docklight for other communication standards such as RS485 and RS422, which
have a different electrical design to RS232 but follow the RS232 communication mechanism.
Docklight has also been successfully tested with many popular USB-to-Serial converters, virtual

null modem software drivers, or Embedded Development tools that appear as a virtual COM port

in Windows.

For RS232 full-duplex monitoring applications, we recommend our Docklight Tap USB accessory,
or our Docklight Monitoring Cable.

This manual only refers to RS232 serial connections in detail, since this is the basis for other serial
connections mentioned above.

TIP: For getting started, have a look at the Docklight sample projects, which demonstrate some of
the basic Docklight functions.

Typical Applications

Docklight is the ideal tool to support your development and testing process for serial
communication devices. Docklight may be used to

e Test the functionality or the protocol implementation of a serial device.
You may define control sequences recognized by your device, send them, log and analyze the
responses and test the device reaction.
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Docklight
Software

RS232 Link +
-

Serial Device
o U — I — |

Tesdting protocol
oF device funchons

¢ Simulate a serial device.
Although rare, the possibility of a hardware fault must be considered in most systems. Imagine
you have a device that sends an error message in the case of a hardware fault. A second device
should receive this error message and perform some kind of reaction. Using Docklight you can
easily simulate the error message to be sent and test the second device's reaction.

Docklicht R5232 Link
Sofwarne
Device 2
- — — — 7 o U — I — |
Ay
| Device 1 | |_ Simulating Device T
I=le=Le=1 - to test Device 2 behavior

¢ Monitor the communication between two devices.
Insert Docklight into the communication link between two serial devices. Monitor and log the
serial communication in both directions. Detect faulty communication sequences or special error
conditions within the monitored communication. Take a snapshot of the communication when
such an error condition has occurred.

RE232 Link

Device 1 Device 2
o o I — | o e I |

Dacklight
Softveare

Manitorng
cormFrunications betwesn
Device {1 and Device 2

2.3  System Requirements

Operating system
e Windows Vista, Windows XP, Windows 2000 or Windows NT

Hardware requirements

e Pentium processor 400 MHz or faster

e Minimum 64 MB RAM

e Minimum one COM port available. Two COM ports for monitoring communication between two
serial devices.

For low-latency monitoring using Docklight Tap: One USB port
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Additional cables or drivers may be required for connecting the equipment to be tested. See the
sections on Docklight Tap, Docklight Monitoring Cable RS232 SUB D9, Standard RS232 Cables
and virtual null modem drivers.
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3
3.1

3.2

User Interface

Main Window

The main window of Docklight is divided into four sections:

| 1. Toolbar and Status

2. Send 4. Communication
SeqUences Whind o

3. Receive

Sequences

1. Toolbar and Status
All main Docklight functions may be selected from the Toolbar. Additional information about the
communication status and the current settings is shown in the status line below it.

2. Send Sequences

Define, edit and manage your Send Sequences here. Using the arrow symbol, the selected
sequence can be sent out immediately. Double click on the blank field at the end of a list to create
a new sequence. The sequence list can be reordered by dragging a sequence to a new position
with the left mouse button pressed. A context menu (right mouse button) is available to cut, copy
or paste entire Send Sequences to/from the Clipboard. See Editing and Managing Sequences and
Dialog: Edit Send Sequence for more information.

3. Receive Sequences

Define, edit and manage your Receive Sequences here. Double click on the blank field at the end
of a list to create a new sequence. The Receive Sequence list supports the same reordering and
clipboard operations as the Send Sequence list. You can also copy a Send Sequence to the
clipboard and paste it into the Receive Sequence list. See Editing and Managing Sequences and
Dialog: Edit Receive Sequence for more information.

4. Communication Window

Displays the outgoing and incoming communication on the serial port. Various display options are
available for communication data, including ASCII / HEX / Decimal / Binary display, time stamps
and highlighting (see Options). If serial communication is stopped, all data from the
communications window may be copied to the clipboard or printed. You may also search for
specific sequences using the Find Sequence function. See How Serial Data is Processed and
Displayed for more information.

Clipboard - Cut, Copy & Paste

Docklight supports the Windows clipboard and its Cut, Copy and Paste operations. Clipboard
operations are available in the

Main Window - Send Sequences

Main Window - Receive Sequences

Main Window - Communication

Main Window - Script Editor (Docklight Scripting only)

Dialog: Edit Send Sequence

Copyright 2009 Flachmann und Heggelbacher



Docklight V1.9 User Manual 05/2009

3.3

Dialog: Edit Receive Sequence
Dialog: Find Sequence
Dialog: Send Sequence Parameter

Notepad
Keyboard Console

You can cut a serial data sequence from the communication window and create a new Send or
Receive Sequence by simply pasting it into the appropriate list. Or edit a Send Sequence, copy a
part of this sequence to the clipboard and create a new Receive Sequence out of it by pasting it
into the Receive Sequence window.

TIP: Try the right mouse button to display a context menu for Cut, Copy and Paste operations.

Notepad

The Docklight Notepad is a separate window for writing down additional notes concerning your
Docklight project (how to use the Send / Receive Sequences, notes on additional test equipment,
etc.). The notepad window can be shown using the F12 key or the menu Tools > Show Notepad.
The notepad is a simple text box that does not offer formatting menus or toolbars, but you can
paste formatted text from the Windowsclipboard.

The notepad contents are stored along with all other Docklight project settings (see saving and
loading your project data). When opening a Docklight project file, the notepad is displayed

automatically, if project notes are available.

NOTE: Closing the notepad window does not delete your notes. They will be still available when
you press F12 again. To remove all notes, empty the text box using Ctrl+A (Select All) and the
DEL key.
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4.2

Features and Functions

How Serial Data Is Processed and Displayed

Docklight handles all serial data in an 8 bit-oriented way. Every sequence of serial data consists of

one or more 8 bit characters. Docklight allows you to

o display the serial data in either ASCII, HEX, Decimal or Binary format

e copy serial data to the clipboard and paste it into a standard text file or a formatted Microsoft®
Word document, or create a Send / Receive Sequence using the data.

e print out serial data, user comments and other information

Docklight's communication window shows the current communication on the selected serial port
(s). Docklight distinguishes between two communication channels (channel 1 and channel 2),
which represent the incoming and outgoing data in Send/Receive Mode or the two communication
channels being observed in Monitoring Mode. Channel 1 and channel 2 data are displayed using
different colors or fonts, and the communication data may be printed or stored as a log file in plain
text or HTML format.

Besides the serial data, Docklight inserts date/time stamps into the communication display. By
default, a date/time stamp is inserted every time the data flow direction switches between channel
1 and channel 2, or before a new Send Sequence is transmitted. There are several options
available for inserting additional time stamps. This is especially useful when monitoring a half-
duplex line with only one communication channel. See Options --> Date/Time Stamps

Docklight is able to process serial data streams containing any ASCII code 0 - 255 decimal. Since
there are non-printing control characters (ASCII code < 32) and different encodings for ASCII code
> 127, not all of these characters can be displayed in the ASCII text window. Nonetheless, all
characters will be processed properly by Docklight and can be displayed in HEX, Decimal or Binary
format. Docklight will process the serial data on any language version of the Windows operating
system in the same way, although the ASCII display might be different. For control characters
(ASCII code < 32), an additional display option is available to display their text equivalent in the
communication window. See Options dialog and Appendix, ASCII Character Set Tables.

Docklight allows you to suppress all original serial data, if you are running a test where you do not
need to see the actual data, but only the additional evaluations generated using Receive
Seguences. See the Project Settings for Communication Filter.

Editing and Managing Sequences

A Docklight project mainly consists of user-defined sequences. These may be either Send
Sequences, which may be transmitted by Docklight itself, or Receive Sequences, which are used
to detect a special message within the incoming serial data.

Sequences are defined using the Edit Send Sequence or Edit Receive Sequence dialog window.
This dialog window is opened

1. by choosing Edit from the context menu available using the right mouse button.

2. by double-clicking on an existing sequence or pressing Ctrl + E with the Send Sequence or
Receive Sequence list selected.

3. when creating a new sequence by double-clicking on the blank field at the end of a list (or
pressing Ctrl + E).

4. when pasting a new sequence into the sequence list.

Docklight supports the use of wildcards (e.g. wildcard "?" as a placeholder for one arbitrary
character) within Receive Sequences and Send Sequences. See the sections sending commands
with parameters and checking for sequences with random characters for details and examples.
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Working with Docklight

Testing a Serial Device or a Protocol Implementation

Diac klight
Softvwane

R5232 Link +
!

Serial Device
o e [ — |

Tegting protocol
oF device funchons

Preconditions

¢ You need the specification of the protocol to test, e.g. in written form.

¢ The serial device to test should be connected to one of the PC's COM ports. See section
Standard RS232 Cables for details on how to connect two serial devices.

e The serial device must be ready to operate.

Performing the test

A) Creating a new project
Create a new Docklight project by selecting the menu File > (1 New Project

B) Setting the Communication Options

1. Choose the menu Tools > E=I' Project Settings...

2. Choose communication mode Send/Receive

3. At Send/Receive on comm. channel, set the COM Port where your serial device is
connected.

4. Set the baud rate and all other COM Port Settings required.

5. Confirm the settings and close the dialog by clicking the OK button.

C) Defining the Send Sequences to be used

You will probably test your serial device by sending specific sequences, according to the protocol
used by the device, and observe the device's reaction. Perform the following steps to create your
list of sequences:

1. Double click on the last line of the Send Sequences table. The Edit Send Sequence dialog is
displayed (see also Editing and Managing Sequences).

2. Enter a Name for the sequence. The sequence name should be unique for every Send
Sequence defined.

3. Enter the Sequence itself. You may enter the sequence either in ASCII, HEX, Decimal or
Binary format. Switching between the different formats is possible at any time using the Edit
Mode radio buttons.

4. After clicking the OK button the new sequence will be added to the Send Sequence lists.

Repeat steps 1 - 4 to define the other Send Sequences needed to perform your test.

D) Defining the Receive Sequences used
If you want Docklight to react when receiving specific sequences, you have to define a list of
Receive Sequences.

Copyright 2009 Flachmann und Heggelbacher
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5.2

1. Double click on the last line of the Receive Sequences table. The dialog Edit Receive
Sequence is displayed. The dialog consist of three parts: Name field, Sequence field, and
Action field.

2. Edit the Name and Sequence fields.

3. Specify an Action to perform after the sequence has been received by Docklight. There are
four types of actions available:
Answer - After receiving the sequence, transmit one of the Send Sequences.
Comment - After receiving the sequence, insert a user-defined comment into the
communication window (and log file, if available).
Trigger - This is an advanced feature described in Catching a specific sequence...
Stop - After receiving the sequence, Docklight stops communications.

4. Click the OK button to add the new sequence to the list.

Repeat steps 1 - 4 to define the other Receive Sequences you need to perform your test.

E) Storing the project
Before running the actual test, it is recommended that the communication settings and sequences
defined be stored. This is done using the menu File > E save Project.

F) Running the test
Start Docklight by choosing Run > ¥ Start Communication.

Docklight will open a serial connection according to the parameters specified. It will then display all

incoming and outgoing communication in the communication window. Use the * | Send button
to send one of the defined sequences to the serial device. The on-screen display of all data
transfer allows you to check the device's behavior. All protocol information can be logged in a text
file for further analysis. Please see section Logging and analyzing a test.

TIP: Using the notepad window (F12 key / menu Tools > Show Notepad), you can easily take
additional notes, or copy & paste parts of the communication log for further documentation.

Simulating a Serial Device

Do klight RS232 Link
Software
Device 2
|_ _____ s Y s [ o |
|
| Device 1 | |_ Simuiating Device T
=== Py to test Device 2 behaviot

Preconditions

¢ You need the specification of the behavior of the serial device you want to simulate, e.g. what
kind of information is sent back after receiving a certain command.
e A second device is connected to a PC COM port, which will communicate with your simulator.

This second device and its behavior is the actual object of interest. An example could be a device
that periodically checks the status of an UPS (Uninterruptible Power Supply) using a serial
communication protocol. You could use Docklight to simulate basic UPS behavior and certain UPS
problem cases. This is very useful when testing the other device, because it can be quite difficult to
reproduce an alarm condition (like a bad battery) at the real UPS.
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NOTE: The second device may also be a second software application. It is possible to run both
Docklight and the software application on the same PC. Simply use a different COM port for each
of the two applications and connect the two COM ports using a RS232 null modem cable. You can
also use a virtual null modem for this purpose.

Performing the test

A) Creating a new project
Create a new Docklight project by selecting the menu File > (1 New Project

B) Setting the Communication Options

1. Choose the menu Tools > E=I' Project Settings...

2. Choose communication mode Send/Receive

3. At Send/Receive on comm. channel, set the COM Port where your serial device is
connected.

4. Set the baud rate and all other COM Port Settings required.

5. Confirm the settings and close the dialog by clicking the OK button.

C) Defining the Send Sequences used

Define all the responses of your simulator. Think of responses when the simulated device is in
normal conditions, as well as responses when in fault condition. In the UPS example mentioned
above, a battery failure would be such a problem case that is hard to reproduce with the original
equipment. To test how other equipment reacts to a battery failure, define the appropriate
response sequence your UPS would send in this case.

NOTE: See Testing a serial device... to learn how to define Send Sequences.

D) Defining the Receive Sequences used

In most cases, your simulated device will not send unrequested data, but will be polled from the
other device. The other device will use a set of predefined command sequences to request
different types of information. Define the command sequences that must be interpreted by your
simulator here.

For every command sequence defined, specify Answer as an action. Choose one of the
sequences defined in C). If you want to use two or more alternative response sequences, make
several copies of the same Receive Sequence, give them a different name (e.g. "status cmd -
answer ok", "status cmd - answer battery failure”, "status cmd - answer mains failure") and assign
different Send Sequences as an action. In the example, you would have three elements in the
Receive Sequences list that would respond to the same command with three different answers.
During the test you may decide which answer should be sent by checking or unchecking the list

elements using the Active column.

E) Storing the project
Before running the actual test, it is recommended that the communication settings and sequences
defined be stored. This is done using the menu File > E save Project.

F) Running the test
Start Docklight by choosing Run > " ¥ Start Communication.

Docklight will now respond to all commands received from the connected serial device.

The on-screen data transfer display allows you to monitor the communications flow. All protocol
information can be logged to a text file for further analysis. See section Logging and analyzing a
test.
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TIP: Using the notepad window (F12 key / menu Tools > Show Notepad), you can easily take
additional notes, or copy & paste parts of the communication log for further documentation.

5.3  Monitoring Serial Communications Between Two Devices

RS232 Link

Device 1 Device 2
o s I — | o o Y — |

Dacklight
S oftweare

Wonitoring
cormrnications betwesan
Device T and Device 2

Preconditions

o A Docklight Monitoring Cable or a Docklight Tap is required to tap the RS232 TX signals of both
serial devices and feed them into Docklight, while not interfering with the communications
between the devices.

¢ For a Docklight Monitoring Cable setup, two COM ports must be available on your PC for
monitoring. Each port will receive the data from one of the serial devices being monitored.

e For a Docklight Tap setup, please make sure you have installed up-to-date USB drivers (FTDI
drivers), as available on our Docklight Download page.

e Device 1 and Device 2 must be ready to operate.

Performing the test

A) Creating a new project
Create a new Docklight project by selecting the menu File > [ New Project

B) Setting the Communication Options

1. Choose the menu Tools > E=I' Project Settings...
2. Choose communication mode Monitoring

Alternative 1 - Using Docklight Monitoring Cable
3. At Receive Channel 1, set the COM Port where the monitoring signal from serial device 1 is
received. At Receive Channel 2, set the COM port for the second device.

NOTE: In Docklight Monitoring Mode, all received data from one COM port is re-sent on the
TX channel of the opposite COM port ("Data Forwarding™). This does not have any effect for
Docklight Monitoring Cable setups, since the TX signal is not connected. But it can be useful
for special applications where you need to route the serial data traffic through Docklight using
standard RS232 cabling. If you require a pure passive monitoring behavior where no TX data
appears, you can disable the "Data Forwarding" using the menu Tools > Expert Options...

Alternative 2 - Using Docklight Tap

3. At Receive Channel 1, open the dropdown list, scroll down to the -- USB Taps -- section and
choose the first Tap port, e.g. TAPO. At Receive Channel 2, the second tap port (e.g. TAP1)
is selected automatically.
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5.4

4. Set the baud rate and all other communication parameters for the protocol being used

NOTE: Make sure your PC's serial interfaces port works properly at the baud rate and for the
communication settings used by Device 1 and Device 2. If Device 1 and 2 use a high speed
data transfer protocol, the PC's serial interfaces and the Docklight software itself might be too
slow to receive all data properly.

5. Confirm the settings and close the dialog by clicking the OK button.

C) Defining the Receive Sequences used

Define Receive Sequences, which should be marked in the test protocol or trigger an action within
Docklight. Docklight checks for Receive Sequence on both monitoring channels, i.e. it does not
matter whether the sequences come from serial device 1 or serial device 2.

NOTE: Since a special monitoring cable is used for this test, all communication between serial
device 1 and serial device 2 will remain unbiased and no additional delays will be introduced by
Docklight itself. This is particularly important when using Docklight for tracking down timing
problems. This means, however, that there is no way to influence the serial communication
between the two devices. While communication mode Monitoring is selected, it is not possible to
use Send Sequences.

D) Storing the project
Before running the actual test, it is recommended to store the communication settings and
sequences defined. This is done using the menu File > E save Project.

E) Running the test

Start Docklight by choosing Run > | ¥ Start Communication, then activate the serial devices 1
and 2 and perform a test run. Docklight will display all communication between serial device 1 and
serial device 2. Docklight uses different colors and font types to make it easy to distinguish
between data transmitted by device 1 or device 2. The colors and font types can be chosen in the

Display tab of the Tools > ﬁ Options... dialog.

TIP: The B Snapshot Function allows you to locate a rare sequence or error condition in a
communication protocol with a large amount of data.

TIP: See the sections How to Increase the Processing Speed... and How to Obtain Best Timing
Accuracy to learn how to adjust Docklight for applications with high amounts of data, or increased
timing accuracy requirements.

Catching a Specific Sequence and Taking a Snapshot of the
Communication

When monitoring serial communications between two devices, you might want to test for a rare
error and the interesting parts would be just the serial communication before and after this event.
You could look for this situation by logging the test and searching the log files for the characteristic
error sequence. This could mean storing and analyzing several MB of data when you are actually
just looking for a few bytes though, if they appeared at all. As an alternative, you can use the
Snapshot feature as described below.

Preconditions

e Docklight is ready to run a test as described in the previous use cases, e.g. monitoring serial
communications between two devices.

Taking a snapshot

A) Defining a trigger for the snapshot
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5.5

5.6

1. Define the sequence that appears in your error situation as a Receive Sequence.
2. Check the Trigger tab in the "action" part of the Receive Sequence dialog: The trigger option
must be enabled if this is the sequence that you want to track down.

NOTE: Do not forget to disable the trigger option for all other Receive Sequences that should be
ignored in your test so that they do not trigger the snapshot.

B) Creating a snapshot

Click on the & Snapshot button of the toolbar. Docklight will start communications, but will not
display anything in the communication window. If the trigger sequence is detected, Docklight will
display communication data before and after the trigger event. Further data is processed, until the
trigger sequence is located roughly in the middle of the communication window. Docklight will then
stop communication and position the cursor at the trigger sequence.

Logging and Analyzing a Test

Preconditions

o Docklight is ready to run a test as described in the previous use cases, e.g.
Testing a serial device or a protocol implementation

Logging the test

Click on the Z Start Logging button on the main toolbar.
A dialog window will open for choosing log file settings.

For each representation (ASCII, HEX, ...), a separate log file may be created. Choose at least one
representation. Log files will have a ".txt" or ".htm" file extension. Docklight additionally adds the
representation type to the file name to distinguish the different log files. E.qg. if the user specifies
"Testl" as the base log file name, the plain text ASCII file will be named "Testl_asc.txt", whereas
an HTML HEX log file will be named "Testl_hex.htm".

Confirm your log file settings and start logging by clicking the OK button.

To stop logging and close the log file(s), click the @ Stop Logging button on the main toolbar.
Unless the log file(s) have been closed, it is not possible to view their entire contents.

Checking for Sequences With Random Characters (Receive
Sequence Wildcards)

Many serial devices support a set of commands to transmit measurement data and other related
information. In common text-based protocols the response from the serial device consists of a
fixed part (e.g. "temperature="), and a variable part, which is the actual value (e.g "65F"). To detect
all these responses correctly in the serial data stream, you can define Receive Sequences
containing wildcards.

Take, for example, the following situation: A serial device measures the temperature and
periodically sends the actual reading. Docklight shows the following output:
10/30/2008 10:20:08.022 [RX] - temperature=82F<CR>

10/30/2008 10:22:10.558 [RX] - temperature=85F<CR>

10/30/2008 10:24:12.087 [RX] - temperature=93F<CR>

10/30/2008 10:26:14.891 [RX] - temperature=102F<CR>
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Defining an individual Receive Sequence for every temperature value possible would not be a
practical option. Instead you would define one Receive Sequence using wildcards. For example:
tlelmlplelrialtiulrie|=|?|#|#|F|r

("r" is the terminating <CR> Carriage Return character)

This ReceiveSequence would trigger on any of the temperature strings listed above. It allows a 1-3
digit value for the temperature (i.e. from "0" to "999"). The following step-by-step example
describes how to define the above sequence. See also the additional remarks at the end of this
section for some extra information on '#' wildcards.

Preconditions

¢ Docklight is ready to run a test as described in the previous use cases, e.g. testing a serial
device or a protocol implementation.
e The serial device (the temperature device in our example) is operating.

Using Receive Sequences with wildcards

A) Preparing the project
Create a new Docklight project and set up all communication parameters.

B) Defining the Receive Sequences used

1. Create a new Receive Sequence. Enter a Name for the sequence.

2. Enter the fixed part of your expected answer in the Sequence section. For our example you
would enter the following sequence in ASCIlI mode:
tlelm|ple|r|altjulr|e]|=

3. Open the popup / context menu using the right mouse button, and choose Wildcard
'?' (matches one character) to insert the first wildcard at the cursor position. Add two '#'
wildcards using the popup menu Wildcard '# (matches zero or one character). The
sequence now looks like this:
tlelm|ple|rlaltiu|r|e[=[?]#]|#

4. Enter the fixed tail of our temperature string, which is a letter 'F' and the terminating <CR>
character. You can use the default control character shortcut Ctrl+Enter to enter the <CR> /
ASCII code 13. The sequence is now:
tlelm|ple|rlaltiulr|e|=]?|#[#]|F]|r

5. Specify an Action to perform after a temperature reading has been detected.

6. Click OK to add the new sequence to the Receive Sequence list.

NOTE: To distinguish the wildcards '?' and '#' from the regular question mark or number sign
characters (decimal code 63 / 35), the wildcards are shown on a different background color within
the sequence editor.

C) Running the test
Start Docklight by choosing Run > " ¥ Start Communication.

Docklight will now detect any temperature reading and perform the specified action.

Additional notes on '#' wildcards

1. The # wildcard enables the user to check for variable-length sequences. However, an algorithm
checking for any possible matching character combination would need to perform an increasing
number of sequence comparisons with every additional "#" wildcard. This becomes obvious if you
replace the '#'-based sequence by an equivalent set of sequences that only contain '?' wildcards
(matches exactly one character).

A check for "Hello#World#!" could be replaced by a check for

"HelloWorld!" plus

"Hello?World!" plus

"HelloWorld?!" plus

"Hello?World?!"
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5.7

As can be seen, every "#" wildcard doubles the number of comparison operations required.
Therefore, Docklight performs a simplified '#' check. The Receive Sequence "Hello#World!" will
work for

"HelloWorld!" or

"HelloXWorld!", but will not trigger on

"HellowWorld!".

The reason for this is that since the first 'W' is considered a part of "World", Docklight forwards its
internal search cursor by one. The next character expected is an '0', but the data stream says 'W'
again, so the comparison algorithm stops here.

Keep this limitation in mind when defining Receive Sequences with '#' wildcards. If you need a
Receive Sequence that triggers on "HellowWorld!" as well, define an additional Receive Sequence
using the *?" wildcard character:

"Hello?World!"

2. '# wildcards immediately before a '?* wildcard have no effect. The search cursor will always be
forwarded to the '?' wildcard, since the '?' matches any arbitrary character. The receive sequence
"Hello##?World" will behave like the receive sequence "Hello?World"

3. '# wildcards at the beginning or at the end of an receive sequence have no effect. The receive
sequence "###HelloWorld###" will behave like the receive sequence "Helloworld".

Saving and Loading Your Project Data

All project data may be saved in a Docklight project file using the menu File > E save Project or
File > Save Project As...

The project data includes

¢ Send Sequences defined

e Receive Sequences defined

additional Project Settings: communication mode, COM ports used, COM port settings (baud
rate, parity, ...)

the Notepad contents

It is recommended to save your current project before starting a test run. Please note the
difference between storing the project settings as described here and logging the communication
during a test (see section logging and analyzing a test). Test run results are stored separately from
Projects.

Loading a project is done using the File > = Open Project... menu.
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Working with Docklight (Advanced Features)

Sending Commands With Parameters (Send Sequence Wildcards)

When testing a serial device, the device will most likely support a number of commands that
include a parameter.

Example: A digital camera supports a command to set the exposure time. For setting the exposure
time to 25 milliseconds, you need to send the following sequence:
e|x|p] 10]2]|5]r ("'risaterminating <CR> Carriage Return character)

To avoid defining a new Send Sequence for every exposure time you want to try, you can use a
Send Sequence with wildcards instead:
elxlpl [?]?2]?]r

The following step-by-step example describes how to define an exposure time command with a
parameter and use a different exposure value each time the sequence is sent.

Preconditions

o Docklight is ready to run a test as described in testing a serial device or a protocol
implementation.

Performing the test using commands with parameters

A) Preparing the project
Create a new Docklight project and set up all communication parameters.

B) Defining the commands used

1. Create a new Send Sequence. Enter a Name for the sequence.

2. Enter the fixed part of your command in the Sequence section. For our example you would
enter the following sequence in ASCII mode:
e[x|p| |

3.  Now open the context menu using the right mouse button, and choose Wildcard
'?" (matches one character) to insert one wildcard at the cursor position. In our example we
would have to repeat this until there are three *?* wildcards for our three-digit exposure time.
The sequence now looks like this:
e[x|p| [?]?]?

4. Now add the terminating <CR> character, using the default control character shortcut Ctrl
+Enter. The example sequence now is
e|x|pl [?]?]?]r

5. Click OK to add the new sequence to the Send Sequence list.

Repeat steps 1 - 5 to define other commands needed to perform your test.

NOTE: To distinguish a '?' wildcard from a question mark ASCII character (decimal code 63), the
wildcard is shown on a different background color within the sequence editor.

C) Sending a command to the serial device

1. Usethe _>| Send button to open the serial communication port and send one command to
the serial device.

2. The communication pauses and the Send Sequence Parameter dialog pops up, allowing you
to enter the parameter value. In our example, an exposure time, e.g. "025".

3. Confirm by pressing Enter. The sequence is now sent to the serial device.
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6.2

It is possible to define commands with several parameters, using several wildcard areas within one
sequence. The Send Sequence Parameter dialog will then appear several times before sending
out a sequence.

NOTE: If you are using Wildcard '?', you must provide exactly one character for each '?' when
sending the sequence. For variable-length parameters use Wildcard '#' (matches zero or one
character).

NOTE: You cannot use a Send Sequence with wildcards as an automatic answer for a Receive
Sequence (see Action).

How to Increase the Processing Speed and Avoid "Input Buffer
Overflow" Messages

When monitoring serial communications between two devices, Docklight cannot control the
amount of incoming data. Since Docklight applies a number of formatting and conversion rules on
the serial data, only a limited number of bytes per seconds can be processed. There are numerous
factors that determine the processing speed, e.g. the PC and COM devices used, the Display
Settings, and the Receive Sequence Actions defined. It is therefore not possible to specify any
typical data rates.

If Docklight cannot keep up with the incoming data, it adds the following comment to the
communication data display:

DOCKLIGHT reports: Input buffer overflow on COM1

TIP: Search for this message using the M Find Sequence in Communication Window... (Ctrl +
F) function.

Docklight will also react slowly to any user input, including a '® Stop communication command.

If you are experiencing the above behavior, Docklight offers you several ways to increase the data
throughput.

1. Simplify the display output:

- Deactivate all unneeded Display Modes in the ﬁ Options... dialog
- Use Plain Text Mode instead of "Formatted Text Output”
- If you are using ASCII mode, disable the Control Characters Description option

2. Log the communication data to a plain text file instead of using the communication window(s):
- Use the "plain text" Log File Format
- Create only a log file for the Representation (ASCII / HEX / Decimal / Binary) you actually
need
- Disable the communication windows while logging, using the High Speed Logging option

3. Use the Communication Filter from the E=I' Project Settings... dialog, and disable the original
serial data for one or both communication directions. This is especially useful if you actually
know what you are looking for and can define one or several Receive Sequences for this
pieces of data. These Receive Sequences can print a comment each time the sequence
appeatrs in the data stream so you still know what has happened, even if the original serial
data is not displayed by Docklight.
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6.3

How to Obtain Best Timing Accuracy

Many RS232 monitoring applications — including Docklight — can only provide limited accuracy
when it comes to time tagging the serial data. As a result, data from the two different
communication directions can be displayed in chronologically incorrect order, or several telegrams
from one communication direction can appear as one chunk of data.

This behavior is not caused by poor programming, but is rather characteristic for a PC/Windows
system, and the various hardware and software layers involved. Unspecified delays and timing
inaccuracies can be introduced by:

The COM device’s chipset, e.g. the internal FIFO (First-In-First-Out) data buffer.

The USB bus transfer (for USB to Serial converters).

The serial device driver for Windows.

The task/process scheduling in a multitasking operating system like Windows.

The accuracy of the date/time provider.

Docklight comes with a very accurate date/time provider with milliseconds granularity, but it still
needs to accept the restrictions from the hardware and software environment around it.

Here is what you can do to minimize additional delays and inaccuracies and achieve a typical time
tagging accuracy of 5 milliseconds or better:

1. Get our Docklight Tap for lowest USB-related latency times. Or use on-board RS232 ports, if
still available on your PC.

2. Choose External / High Priority Process Mode in the Tools > Expert Options... dialog.

3. When monitoring high amounts of data, use the recommendations from the previous section
How to Increase the Processing Speed... to avoid input buffer overflows and that the
computer become irresponsive because of high CPU usage.

NOTE: The Expert Options... recommended above will change the overall system balance and
must be used with care. Best results can be achieved only when logged in as an Administrator.
Please make sure you understood the remarks and warning in the documentation.
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7 Examples and Tutorials

This chapter describes two sample projects that demonstrate some of Docklight's basic functions.
The corresponding Docklight project files (.ptp files) can be found in the \Samples folder within the
Docklight installation directory (e.g. C:\Program Files\FuH\Docklight V1.9\Samples).

NOTE: If you are logged on with a restricted user account, you will not have permission to make
any changes in the program files directory. In this case, saving a project file or any other data into
the \Samples folder will produce an error.

NOTE: For additional sample projects and Application Notes, see our online resources at www.
docklight.de/examples _en.htm

7.1  Testing a Modem - Sample Project: ModemDiagnostics.ptp

The Docklight project ModemDiagnostics.ptp can be used to perform a modem check. A set of
modem diagnostic commands are defined in the Send Sequences list.

This is a simple example for Testing a serial device or a protocol implementation. The sample
project uses the communication settings listed below. This should work for most standard

modems.
Communication Mode Send/Receive
COM Port Settings 9600 Baud, No parity, 8 Data Bits, 1 Stop Bit

Getting started

e Connect the modem to an available COM port, e.g. COM1, and switch it on. The demo may also
run on a notebook with a built-in modem. In many cases you will find your notebook'’s built-in
modem on COM3, so you can try and run the demo without modifying the project settings.

¢ Go to the k=I' Project Settings... dialog and make sure you have selected the same COM Port
for Send/Receive on comm. channel.

e Press the | * Start Communication button in the toolbar.

e Try sending any of the predefined modem commands by pressing the * | Send button

You should now receive a response from your modem, e.g. "OK" if your command was accepted,
a model identification number, etc. The response will vary with the modem model.

After sending several sequences, the Docklight communication window could look like this:
3/8/2009 15:00:44.034 [TX] - ATQOV1EO<CR><LF>

3/8/2009 15:00:44.040 [RX] - <CR><LF>
OK<CR><LF>

3/8/72009 15:00:44.608 [TX] - AT+GMM<CR><LF>
37872009 15:00:44.610 [RX] - <CR><LF>

H.324 video-ready rev. 1.0<CR><LF>

<CR><LF>

OK<CR><LF>

37872009 15:00:45.049 [TX] - AT+FCLASS=?<CR><LF>

3/8/2009 15:00:45.060 [RX] - <CR><LF>
0,1,8<CR><LF>
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Further Information
The Send Sequences list includes the following standard AT modem commands:
Send Sequence Description / Modem Response
ATQOV1EO Initializes the query.
AT+GMM Model identification (ITU V.250 recommendation is not
supported by all modems).
AT+FCLASS=? Fax classes supported by the modem, if any.
AT#CLS=? Shows whether the modem supports the Rockwell voice
command set.
ATl<n> Displays manufacturer's information for <n> = 1 through 7.
This provides information such as the port speed, the
result of a checksum test, and the model information.
Check the manufacturer's documentation for the expected
results.
The \Samples folder also contains a log file ModemDiagnostics_Lodfile_asc.txt. It shows a test
run where the above Send Sequences were sent to a real modem.
7.2 Reacting to a Receive Sequence - Sample Project: PingPong.ptp

The Docklight project PingPong.ptp is a simple example for how to define and use Receive
Sequences.

Getting started

e Go to the = Project Settings... dialog and choose a COM port.

o Apply a simple loopback to this COM port: Connect Pin 2 (RX) with Pin 3 (TX). See RS232 SUB
D9 Pinout.

started and the Send Sequence is transmitted. It will of course be instantly received on the COM
port's RX line.

Docklight will detect the incoming data as being one of the defined Receive Sequences. It will then
perform the action predefined for this event, which is sending out another sequence. As a result,
Docklight will send out alternating Send Sequences - "Ping" and "Pong".

e Use the ‘B Stop communication button to end the demo.

The Docklight communication display should look similar to this:

3/8/2009 16:25:44.201 [TX] - ----0 Ping
3/8/2009 16:25:44.216 [RX] - ----0 Ping "Ping"” received
3/8/2009 16:25:44.218 [TX] - o---- Pong
3/8/2009 16:25:44.233 [RX] - o---- Pong "'Pong" received
3/8/2009 16:25:44.236 [TX] - ----0 Ping
3/8/2009 16:25:44.251 [RX] - ----0 Ping "Ping" received
3/8/2009 16:25:44.254 [TX] - o---- Pong
3/8/2009 16:25:44.268 [RX] - o---- Pong "'Pong" received
3/8/2009 16:25:44.271 [TX] - ----0 Ping
3/8/2009 16:25:44.286 [RX] - ----0 Ping "Ping"” received
3/8/2009 16:25:44.289 [TX] - o---- Pong
3/8/2009 16:25:44.303 [RX] - o---- Pong "'Pong" received
3/8/2009 16:25:44.307 [TX] - ----0 Ping
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3/8/72009 16:25:44.322 [RX] - ----0 Ping "Ping" received
3/8/2009 16:25:44.324 [TX] - o---- Pong

See also the corresponding log files in the \Samples folder (PingPong_Logfile_asc.htm and
PingPong_Logdfile_hex.htm).

Further Information

This demo project can also be run in three alternative configurations:

1. Run two Docklight applications on the same PC using different COM ports. The two COM
ports are connected using a simple null modem cable.

2. Instead of two RS232 COM ports and a null modem cable you can use a virtual null modem.

3. Use two PCs and run Docklight on each PC. Connect the two PCs using a simple null modem
cable.

Copyright 2009 Flachmann und Heggelbacher



22

Docklight V1.9 User Manual 05/2009

Reference

Menu and Toolbar

File Menu

[ New Project
Close the current Docklight project and create a new one.

= Open Project ...
Close the current Docklight project and open another project.

Import Sequence List ...
Import all Send Sequences and Receive Sequences from a second Docklight project.

E save Project / Save Project As ...
Save the current Docklight project.

Print Project ...

Print the project data, i.e. the list of defined Send Sequences and Receive Sequences. The
sequences are printed in the same representation (ASCII, HEX, Decimal or Binary) that is used in
the Docklight main window. The representation may be chosen using the Options dialog window.

&) Print Communication ...
Print the contents of the communication window. The communication data is printed in the same
representation that is currently visible in the communication window.

Exit
Quit Docklight.

Edit Menu

Edit Send Sequence List ...
Edit the Send Sequences list, i.e. add new sequences or delete existing ones.

Edit Receive Sequence List ...
Edit the Receive Sequences list, i.e. add new sequences or delete existing ones.

Swap Send and Receive Sequence Lists
Convert all Send Sequences into Receive Sequences and vice versa.

M Find Sequence in Communication Window...
Find a specific sequence within the data displayed in the communication window. See the Find
Sequence function.

[l clear communication Window
Delete the contents of the communications window. This applies to all four representations (ASCII,
HEX, Decimal, Binary) of the communication window.

Run Menu

F Start communication
Open the communication ports and enable serial data transfer.

B Stop communication
Stop serial data transfer and close the communication ports.
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8.2

Tools Menu

Z Start Communication Logging ...
Create new log file(s) and start logging the incoming/outgoing serial data. See logging and

analyzing a test.

@ Stop Communication Logging
Stop logging and close the currently open log file(s).

& Start Snapshot Mode
Wait for a trigger sequence and take a snapshot. See Catching a specific sequence...

& Stop Snapshot Mode
Abort a snapshot and reenable the communication window display.

% Keyboard Console On
Enable the keyboard console to send keyboard input directly.

g% Keyboard Console Off
Disable the keyboard console.

Show Notepad
Show the notepad window.

Project Settings...
Select the current project settings (communication settings, flow control settings, communication
filter...).

ﬁ Options...
Select general settings (e.g. display).

Expert Options...
Select expert program options intended for advanced users and specific applications (e.g. high
monitoring accuracy).

Dialog: Edit Send Sequence

This dialog is used to define new Send Sequences and edit existing ones (See also Editing and
Managing Sequences).

Index
The index of the sequence displayed below. The first sequence has index 0 (zero).

1 - Name

Unique name for this sequence (e.g. "Set modem speaker volume"). This name is for referencing
the sequence. It is not the data that will be sent out through the serial port. See "2 - Sequence"
below.

2 - Sequence
The character sequence that will be transmitted through the serial port.

3 - Additional Settings
Check the "Send periodically..." option to define a sequence that is sent periodically. A time interval
between 0.01 seconds and 9999 seconds can be specified.
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8.3

NOTE: The Windows reference time used for this purpose has only limited precision. Time
intervals < 0.03 seconds will usually not be accurate.

Wildcards

Wildcards can be used to introduce parameters into a Send Sequence that you wish to insert
manually each time the sequence is sent. See section Sending commands with parameters for
details and examples.

Control Character Shortcuts

Using keyboard shortcuts is a great help when editing a sequence that contains both printing
characters (letters A-z, digits 0-9, ...) and non-printing control characters (ASCII code 0 to 31).
Predefined shortcuts are:

Ctrl+Enter for carriage return / <CR> / decimal code 13

Ctrl+Shift+Enter for line feed / <LF> / decimal code 10

Use ﬁ Options... --> Control Character Shortcuts to define other shortcuts you find useful.

Dialog: Edit Receive Sequence

This dialog is used to define new Receive Sequences and edit existing ones (See also Editing and
Managing Sequences).

Index
The index of the sequence displayed below. The first sequence has index 0 (zero).

1 - Name
Unique name for this sequence (e.g. "Ping received"). This name is for referencing the sequence.
It is not the sequence received through the serial port. See "2 - Sequence" below.

2 - Sequence
The character sequence which should be detected by Docklight within the incoming serial data.

3 - Action
The action(s) performed when Docklight detects the sequence defined above.

You may choose from the following actions:

o Answer - After receiving the sequence, transmit one of the Send Sequences. Only Send
Sequences that do not contain wildcards can be used as an automatic answer.

e Comment - After receiving the sequence, insert a user-defined comment into the
communication window (and log file, if available).

e Trigger - Trigger a snapshot when the sequence is detected. This is an advanced feature
described in the section Catching a specific sequence...

e Stop - Stop communications and end the test run.

Wildcards

Wildcards can be used to test for sequences that have a variable part with changing values (e.g.

measurement or status values). See section Checking for sequences with random characters for
details and examples.

Control Character Shortcuts

Using keyboard shortcuts is a great help when editing a sequence that contains both printing
characters (letters A-z, digits 0-9, ...) and non-printing control characters (ASCII code 0 to 31).
Predefined shortcuts are:

Ctrl+Enter for carriage return / <CR> / decimal code 13

Ctrl+Shift+Enter for line feed / <LF>/ decimal code 10

Use ﬁ Options... --> Control Character Shortcuts to define other shortcuts you find useful.
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8.4

8.5

Dialog: Create Log File(s)
Menu Tools > Z Start Communication Logging ...

Log file format

The available log formats are plain text (.txt) files or HTML files for web browsers (.htm). Plain text
files are a good choice if you expect your log files to become very large. HTML log files are more
comfortable to analyze, because they include all the visual formatting of the communication
windows (colors, bold characters, italic characters). However, the file will be larger than a plain text
file and some browsers may process large HTML files quite slowly. If you have specific
requirements on the output format, you can customize the HTML output.

Log file directory and base name

Choose the directory and base file name for the log file(s) here. The actual file path used for the
individual log file representations are displayed in the text boxes within the "Log file representation”
frame.

Overwrite / append mode

Choose "append new data" if you do not want Docklight to overwrite existing log file(s). Docklight
will then insert a "start logging / stop logging" message when opening / closing the log files. This is
so that when in 'append mode' it is still possible to see when an individual log file session started
or ended.

Representation

A separate log file may be created for each data representation (ASCII, HEX, ...). Choose at least
one representation. The log files will have a ".txt" or ".htm" file extension. Docklight additionally
adds the representation type to the file name to distinguish the different log files. E.g. if the user
specifies "Testl" as the base log file name, the plain text ASCII log file will be named "Testl_asc.
txt", whereas the plain text HEX log file will be named "Testl_hex.txt".

High speed logging

If you are monitoring a high speed communication link or if you are running Docklight on a slow
computer, Docklight may not be able to catch all the transmitted data or may even freeze (no
response to any user input). In this case, try disabling the communication window output while
logging the data to a file. Docklight will run much faster, since the display formatting uses
considerable CPU time.

Dialog: Find Sequence

Menu Edit > ®™ Find Sequence in Communication Window...

The Find Sequence function searches the contents of the communication window. The search is
performed in the communication window tab that is currently selected (ASCII, HEX, Decimal or
Binary). You may, however, define your search string in any other representation.

Searching the communication windows is only possible if the communication is stopped.

You can search for anything that is already defined as a Send Sequence or a Receive Sequence,
or you may define a custom search sequence.

NOTE: If you are looking for a sequence within the ASCIl communication window, please

remember the following limitations:

e The Find Sequence function is not able to locate sequences containing non-printing control
characters (ASCII decimal code < 32) or other special characters (decimal code > 127). This is
due to the nature of the ASCII display. Search using the HEX or Decimal communication window
tab instead.

¢ In ASCIl mode, the Find Sequence function will treat date/time stamps and any other
comments in the same way as regular communication data. In HEX / Decimal / Binary mode, all
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8.7

additional information is ignored as long as it does not look like a character byte value.

Dialog: Send Sequence Parameter

Type in one or several value(s) for a Send Sequence with wildcards here. As with the Edit Send/
Receive Sequence dialog, you may use control character shortcuts or clipboard functions.
Parameter No.

A Send Sequence can contain any number of wildcards. Each set of consecutive wildcards is
considered a separate parameter. The value for each parameter is entered separately.

Minimum Characters Required
For each "?' wildcard exactly one character is required. Therefore, the minimum number of
characters required is equal to the number of '?' wildcards within one parameter.

NOTE: While the Send Sequence Parameter dialog is shown, all serial communication is paused.
Docklight does not receive any data and does not send any (periodical) Send Sequences.

Dialog: Project Settings - Communication
Menu Tools > =I' Project Settings... | Communication
Communication Mode

Send/Receive

Docklight acts both as transmitter and receiver of serial data. This mode is used when Testing the
functionality or the protocol implementation of a serial device or simulating a serial device.

Naming conventions: The received data (RX) will be displayed and processed as "Channel 1", the
transmitted data (TX) will be displayed as "Channel 2".

Monitoring

Docklight receives serial data on two different communication channels. This mode is used, for
example, when Monitoring the communication between two devices.

Naming conventions: The serial data from device 1 is "Channel 1", the data from device 2 is
"Channel 2".

Communication Channels - Serial COM ports or Docklight TAP ports

Choose one (or in Monitoring Mode: two) COM ports from the dropdown list. The dropdown list
shows all COM ports available on your PC via the Windows operating system. You can also type in
any COM port from COM1 to COM256 manually.

For Docklight Tap monitoring applications, open the dropdown list and choose the TAP port (e.qg.
TAPO for Channel 1, and TAP1 for Channel 2) from the 'USB Tap' section below the COM ports.
The TAP connections are only available if Communication Mode is set to 'Monitoring', the
Docklight Tap is plugged in and the Docklight Tap USB device drivers are installed properly.

COM Port Settings

Baud Rate
Choose a standard baud rate from the dropdown list, or use a non-standard baud rate by typing
any integer number between 110 and 9999999.

NOTE: Non-standard baud rates may not work correctly on all COM ports, dependant on the
capabilities of your COM port's hardware UART chip. You will receive no warning, if any non-
standard rate cannot be applied.

NOTE: Although Docklight's Project Settings allow you to specify baud rates up to 9 MBaud, this
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does not mean Docklight is able to handle this level of throughput continuously. The average data
throughput depends very much on your PC's performance and the Docklight display settings. See
also How to Increase the Processing Speed.

Data Bits and Stop Bits
Specify the number of data bits and stop bits here. As with the baud rate, some of the available
settings may not be supported by the COM port device(s) on your PC.

Parity

All common parity check options are available here. (The settings 'Mark' and 'Space’ will probably
not be used in practical applications. 'Mark' specifies that the parity bit always is 1, 'Space' that the
parity bit is always 0, regardless of the character transmitted.)

Parity Error Character

This is the character that replaces an invalid character in the data stream whenever a parity error
occurs. You should specify an ASCII character (printing or non-printing) that does not usually
appear within your serial data stream. Characters may be defined by entering the character itself
or entering its decimal ASCII code (please enter at least two digits).

NOTE: Choose "(ignore)" for the Parity Error Character if you need to transmit/receive the parity bit

but Docklight should preserve all incoming characters, even when the parity bit is wrong. This is
useful for applications where a 9th bit is used for addressing purposes and not for error checking.

Dialog: Project Settings - Flow Control
Menu Tools > =I' Project Settings... | Flow Control

Used to specify additional hardware or software flow control settings for serial communications in
Docklight Send/Receive Mode.

Flow Control Support

Off
No hardware or software flow control mechanism is used. RTS and DTR are enabled when the
COM port is opened.

Manual

Use this mode to control the RTS and DTR signals manually and display the current state of the
CTS, DSR, DCD and Rl lines. If flow control is set to "Manual”, an additional status element is
displayed in the Docklight main window. You may toggle the RTS and DTR lines by double clicking
on the corresponding indicator.

NOTE: Flow control signals are not treated as communication data and will not be displayed in the
communication window or logged to a file.

Hardware Handshaking, Software Handshaking
Support for RTS/CTS hardware flow control and XON/XOFF software flow control. These are
expert settings rarely required for recent communication applications.

RS485 Transceiver Control

Some RS232-t0-RS485 converters require manual RTS control, i.e. the RS232 device (PC) tells
the converter when it should enable its RS485 driver for transmission. If you choose "RS485
Transceiver Control", the COM port sets RTS to High before transmitting the first character of a
Send Sequence, and resets it to Low after the last character has been transmitted.

NOTE: Many USB-to-Serial converters or virtual COM port drivers do not implement the Windows
RTS_CONTROL_TOGGLE mode properly. If you experience problems with RS485 Transceiver
Control, try using a PC with an on-board COM interface or a standard PClI COM card.

Copyright 2009 Flachmann und Heggelbacher



28

Docklight V1.9 User Manual 05/2009

8.9

8.10

Dialog: Project Settings - Communication Filter
Menu Tools > =l Project Settings... | Communication Filter

Use the Contents Filter option if you do not need to see the original communication data on the
serial line and only require the additional comments inserted by a Receive Sequence. This is
useful for applications with high data throughput, where most of the data is irrelevant for testing
and you only need to watch for very specific events. These events (and related display output) can
be defined using Receive Sequences.

Dialog: Options
Menu Tools > ﬁ Options...
Display

Formatted Text Output (Rich Text Format)

used for setting the appearance of the Docklight communication window. The two different serial
data streams, "Channel 1" and "Channel 2", may be displayed using different colors and styles.
The standard setting uses different colors for the two channels, but using different font styles (e.g.
Italics for "Channel 2") is also possible. You may also choose the overall font size here.

NOTE: If you change the font size, the communication window contents will be deleted. For all
other changes, Docklight will try to preserve the display contents.

Plain Text Output (faster display, but no colors & fonts)

The formatted text output is similar to a word processor and consumes a considerable amount of
CPU time. It also requires frequent memory allocation and deallocation which might decrease your
PC performance. So if you are monitoring a high-speed communication link, but still want to keep
an eye on the serial data transferred, try using the "Plain Text Output" format.

Control Characters (ASCII 0 - 31)

For communication data containing both printing ASCII text as well as non-printing control
characters, it is sometimes helpful to see the names of the occurring control characters in the
ASCII mode display window. Docklight provides an optional display settings to allow this. You can
also suppress the control characters (except CR and LF) for cases when this would clutter your
display.

Display Modes

Communication Window Modes

By default, Docklight will display four representations of the serial data streams: ASCII, HEX,
Decimal and Binary. You may deactivate some of these modes to increase Docklight's overall
performance. For example, the Binary representation of the data is rarely required. Disabling
Binary mode for the communication window will considerably increase processing speed. Even
when turned off for the communication window, logging in all formats is still possible.

See also the Plain Text Output option above.

Date/Time Stamps

Adding a Date/Time Stamp

Docklight adds a date/time stamp to all data that is transmitted or received. You may choose to
insert this date/time stamp into the communication window and the log file whenever the data flow
direction changes between Channel 1 and Channel 2.
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For applications where the data flow direction does not change very often, you may want to have
additional date/time stamps at regular time intervals. For this, activate the Clock - additional date/
time stamp... option then and choose a time interval.

On a half duplex line (e.g. 2 wire RS485), changes in data direction are difficult to detect. Still, in
most applications there will be a pause on the communication bus before a new device starts
sending. Use the Pause detection... option to introduce additional time stamps and make the
pauses visible in your communication log.

Date/Time Format
Docklight offers time stamps with a resolution of up to 1/1000 seconds (1 millisecond). For
compatibility to earlier Docklight versions (V1.8 and smaller), 1/100 seconds is available, too.

NOTE: The resulting time tagging accuracy can be considerably different, e.g. 10-20 milliseconds
only. The actual accuracy depends on your serial communications equipment, your PC
configuration, the Docklight Display Settings (see above) and the Docklight Expert Options. See
the section How to Obtain Best Timing Accuracy for details.

Control Characters Shortcuts

Here you can define your own keyboard shortcuts for ASCII Control Characters (ASCII code < 32),
or for any character code > 126. Keyboard shortcuts can be used within the following Docklight
dialogs and functions

Dialog: Edit Send Sequence

Dialog: Edit Receive Sequence

Dialog: Find Sequence

Dialog: Send Sequence Parameter

Keyboard Console

For each character from decimal code 0 to 31 and from 127 to 255, you can define a keyboard
combination to insert this character into a sequence (Shortcut). You may also define a letter which
is used to display this control character when editing a sequence in ASCIl mode (Editor).

Double click to change the value of a Shortcut or Editor field.

Predefined shortcuts are:
Ctrl+Enter for carriage return / <CR> / decimal code 13
Ctrl+Shift+Enter for line feed / <LF> / decimal code 10

Dialog: Customize HTML Output

This dialog allows you to change the appearance of the HTML log files, by modifying the HTML
template code that Docklight uses when generating the HTML log file data.

You need some basic understanding of HTML documents and CSS style attributes. We
recommend http://www.htmldog.com (English) or http://www.selfhtml.org (German and French) for
a quick overview on these topics.

HTML Header Template
The HTML document header. Here you can change the font applied to the log file data, using the
following CSS style attributes:

CSS Style Attribute Description and Example

font-family Defines one or several fonts (or: font categories) that the HTML
browser should use to print a text. If the browser does not support
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the first font, it will try the second one, a.s.o. The last font usually
defines a generic font category that every browser supports.
Examples:
font-family:"Courier New", Courier, monospace
font-family:"Times New Roman®, Times, serif
font-family:arial, helvetica, sans-serif
font-size Specifies the font size. Both, absolute and relative sizes are
possible. Examples for absolute font sizes:
font-size:12pt
font-size:xx-small
font-size:x-small
font-size:small
font-size:medium
font-size:large
font-size:x-large
font-size:xx-large
Examples for relative font sizes (relative to the parent HTML
element)
font-size:smaller
font-size:larger
font-size:90%
NOTE: Use the semicolon (";") as a separator between two different CSS style attributes, e.g.
font-family:sans-serif; font-size:small
NOTE: Docklight will insert additional <u> (underline), <i> (italic) and <b> (bold) HTML tags, if such
formatting options are activated in the Display Settings. You do not have to use the font-style or
font-weight attribute to create these effects.
HTML Footer Template
Adds additional footer text and closes the HTML document.
Data Element Template
For every new piece of log file information (channel 1 data, channel 2 data, or a comment text), a
new <span> tag with different text color is added to the HTML log file.
The template code for the header, footer and data parts contains Docklight-specific wildcards
which must not be deleted:
Wildcard Description
%BACKCOLOR% The background color, as selected in the Display Settings
%HEADERMSG% Header text at the start of the log file
%FOOTERMSG% Footer text at the end of the log file
%DATA% a chunk of the log file data: channel 1 data, channel 2 data, or a
comment text
%TEXTCOLOR% The text color to apply for %DATA%, as selected in the Display
Settings
When generating a log file, Docklight replaces the wildcards with the current display settings and
the actual communication data.
8.12 Dialog: Expert Options

Menu Tools > Expert Options...

Expert Options are additional settings for specialized applications with additional requirements (e.
g. high time tagging accuracy).
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Performance
Communication Driver Mode

Use External / High Priority Process mode to work around a common problem for any Windows
user mode application: unspecified delays and timing inaccuracies can be introduced by the
Windows task/process scheduling, especially if you are running other applications besides
Docklight. External / High Priority Process mode is recommended for high accuracy / low
latency monitoring using the Docklight Tap.

In External / High Priority Process mode, the data collection in Docklight becomes a separate
Windows process with realtime priority class. It will be executed with higher priority than any other
user application or additional application software like Antivirus. For best results you need to be
logged in as an Administrator. Otherwise the data collection process will run with the maximum
permitted priority, but not "realtime class".

NOTE: External / High Priority Process mode must be used with care, especially when you
intend to monitor a high-speed data connection with large amounts of data. The PC might become
irresponsive to user input. To resolve such a situation, simply "pull the plug": First disconnect the
data connections or the monitoring cable to bring down the CPU load and restore the

responsiveness. Then choose ‘B Stop communication in Docklight.

NOTE: See the section How to Obtain Best Timing Accuracy for some background information on
timing accuracy.

Docklight Monitoring Mode

When Monitoring Serial Communications Between Two Devices, all received data from one COM
port is re-sent on the TX channel of the opposite COM port by default ("Data Forwarding"). This is
intended for special applications that require routing the serial data traffic through Docklight using
standard RS232 cabling.

Use the No Data Forwarding Expert Option for applications with two serial COM ports where you
need to avoid that any TX data is sent. This can be used to improve performance when using a
Docklight Monitoring Cable, or to work around problems caused with instable serial device drivers.

For Docklight Tap applications (e.g. using Communication Channel TAPO / TAP1), the 'Data
Forwarding' setting has no effect. The Docklight Tap is accessed in read-only mode always, and
no data is forwarded.

Keyboard Console

The Keyboard Console tool allows you to send keyboard input directly to the serial port. It can be

activated using the menu Tools > % Keyboard Console On. The keyboard console is only
available for communication mode Send/Receive.

After activating the keyboard console, click in the communication window and type some
characters.

Docklight will transmit the characters directly through the selected serial port. The communication
window will display the characters the same way it does a Send Sequence.

NOTE: The Keyboard Console tool supports pasting and transmitting a character sequence from
the clipboard, using Ctrl + V. This is similar to pasting clipboard data inside the Edit Send
Sequence Dialog. Clipboard contents that exceeds the maximum sequence size of 1024
characters gets truncated.

NOTE: The keyboard console is not a full-featured terminal and does not support specific terminal
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standards, such as VT 100. The Enter key is transmitted as <CR> (ASCII 13) plus <LF> (ASCII
10), as per the Windows standard text file format. Use control character shortcuts to send other

ASCII control characters.
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9 Support
9.1 Web Support and Troubleshooting

For up-to-date FAQs and troubleshooting information, see our online support pages available at

http://www.docklight.de/support _en.htm

9.2 E-Mail Support

We provide individual e-mail support to our registered customers. Please include your Docklight
license key number in your request. We will contact you as soon as possible to find a solution to
your problem. Send your support request to

docklight@fuh-edv.de
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10.1

Appendix
ASCII Character Set Tables

Control Characters

Dec Hex  ASCII Char. Meaning

0 00 NUL Null

1 01 SOH

2 02 STX Start of text

3 03 ETX

4 04 EOT End of transmission
5 05 ENQ Enquiry

6 06 ACK

7 07 BEL Bell

8 08 BS Backspace

9 09 HT Horizontal tab
10 OA LF Line feed

11 OB VT Vertical tab

12 ocC FF Form feed

13 oD CR Carriage return
14 OE SO Shift out

24 18 CAN Cancel

27 1B ESC Escape

Printing Characters

Dec Hex  ASCII Char. Meaning

Start of heading

Break/end of text

End of medium
substitute/end of file

File separator
Group separator
Record separator
Unit separator

32 20 Space
33 21 ! !
34 22 " "
35 23 # #
36 24 $ $
37 25 % %
38 26 & &
39 27 " -
40 28 ( (
41 29 ) )
42 2A * *
43 2B + +
44 2C , ,
45 2D - -
46 2E - -
47 2F / /

Positive acknowledgment

Shift Iin/XON (resume output)
Data link escape

XON - Device control
Device control
XOFF - Device control
Device control
Negative Acknowledgment
Synchronous idle

End of transmission block

character 1
character 2

character 3

character 4
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48 30 0
49 31 1
50 32 2
51 33 3
52 34 4
53 35 5
54 36 6
55 37 7
56 38 8
57 39 9
58 3A :
59 3B ;
60 3C <
61 3D =
62 3E >
63 3F ?
64 40 @
65 41 A
66 42 B
67 43 C
68 44 D
69 45 E
70 46 F
71 47 G
72 48 H
73 49 |
74 4A J
75 4B K
76 4C L
77 4D M
78 4E N
79 4F 0
80 50 P
81 51 Q
82 52 R
83 53 S
84 54 T
85 55 u
86 56 V
87 57 W
88 58 X
89 59 Y
90 5A Z
91 5B [
92 5C \
93 5D 1
94 5E N
95 5F _
96 60 "
97 61 a
98 62 b
99 63 C
100 64 d
101 65 e
102 66 T
103 67 g
104 68 h
105 69 i
106 6A J
107 6B k
108 6C |
109 6D m
110 6E n
111 6F o

Zero
One
Two
Three
Four
Five
Six
Seven
Eight
Nine

D /PN X =E<CHOVWTODO UVOZZIrXRGQ@e=TOTIMOOTWIZE@ DV Il Awr

|

O S mXmmTQ=0QO0O0TQ
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112 70 p p
113 71 q q
114 72 r r
115 73 S s
116 74 t t
117 75 u u
118 76 \Y; \Y;
119 77 w w
120 78 X X
121 79 y y
122 TA z z
123 7B { {
124 7C | |
125 7D } }
126 7E ~ Tilde
127 7F DEL Delete
10.2 HotKeys

General Hot Keys

Applies to

e Communication window (ASCII, HEX, Decimal, Binary)
¢ Edit Send Sequence dialog / Edit Receive Sequence dialog

e Docklight Notepad

Function Hot Key
Context-specific help F1

Cut Ctri+X
Copy ctri+C
Paste Ctri+v
Delete Del
Select all Ctri+A
Context-specific Hot Keys

Docklight menu

Menu Function Hot Key
File New Project Ctri+N
File Open Project Ctri+0
File Save Project Ctri+S
Edit Find Sequence in Comm.Window Ctri+F
Run Start Communication F5

Run Stop Communication F6
Tools Keyboard Console On Ctri+F5
Tools Keyboard Console Off Ctrl+F6
Tools Show / Hide Docklight Notepad F12
Communication Window

Function Hot Key
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Find a Sequence Ctri+F
Clear All Communication Windows Ctri+w
Toggle Between ASCII, HEX, Decimal and Binary |Ctri+Tab
Representation

Send Sequences / Receive Sequences List

Function Hot Key
Delete This Sequence Del

Edit This Sequence Ctrl+E
Send This Sequence Space

- Send Sequences List only -

Edit Send Sequence Dialog / Edit Receive Sequence Dialog

Function Hot Key
Cancel Esc
Wildcard '?' (matches one character) F7
Wildcard '# (matches one or zero characters) F8
Notepad Window

Function Hot Key
Default Font Ctrl+D

RS232 Connectors / Pinout

The most common connectors for RS232 communication are

e 9-pole SUB D9 (EIA/TIA 574 standard). Introduced by IBM and widely used. See below.

37

e 25-pole SUB D25 (RS232-C). This is the original connector introduced for the RS232 standard.

It provides a secondary communication channel.

e 8-pole RJ45 (RS232-D, according to EIA/TIA-561 standard).

RS232 SUB D9 Pinout

View: Looking into the male connector.

Pinout: From a DTE perspective (the DTE transmits data on the TX Transmit Data line, while the

DCE receives data on this line)

Dﬁ Q? Oﬂ OH

Pin No. [Signal Name ([Description DTE in/out
1 IDCD Data Carrier Detect Input

2 [RX Receive Data Input

3 [T Transmit Data Output
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4 IpTR Data Terminal Ready Output
5 SGND Signal Ground -

6 [DSR Data Set Ready Input

7 IRTS Request To Send Output
8 CTS Clear To Send Input
9 [RI Ring Indicator Input

RS232 SUB D25 Pinout

View: DTE perspective, looking into the male connector

G1 GZ 03 Gal Gﬁ CJEi G? Gﬂ GH c::'1I] 011 t:}12 c}13
DH D15 D1E Gﬁ 013 019 DZI] D21 {322 023 DZ# 'DEE

Pin No. [Signal Name ([Description

1 - Protective/Shielding Ground

2 TX Transmit Data

3 [RX Receive Data

4 IRTS Request To Send

5 CTS Clear To Send

6 DSR Data Set Ready

7 SGND Signal Ground

8 DCD Data Carrier Detect

9 - Reserved

10 - Reserved

11 - Unassigned

12 SDCD Secondary Data Carrier Detect

13 SCTS Secondary Clear To Send

14 STX Secondary Transmit Data

15 TXCLK Transmit Clock

16 SRX Secondary Receive Data

17 [RxCLK Receive Clock

18 ILL Local Loopback

19 SRTS Secondary Request To Send

20 IDTR Data Terminal Ready

21 RL/SQ Remote Loopback / Signal
Qualify Detector

22 IRI Ring Indicator

23 CH/CI Signal Rate Selector

24 ACLK Auxiliary Clock

25 - Unassigned

RS232-D, RJ45 pinout
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View: Top View: Front

1 8 g 1

Pin No. ||Signa| Name [Description

1 IDSR/RI Data Set Ready / Ring Indicator
2 IDCD Data Carrier Detect

3 IDTR Data Terminal Ready

4 SGND Signal Ground

5 RX Receive Data

6 TX Transmit Data

7 CTS Clear To Send

8 [RTS Request To Send

10.4 Standard RS232 Cables
RS232 Connections

When connecting two serial devices, different cable types must be used, depending on the
characteristics of the serial device and the type of communication used.

Overview of RS232 SUB D9 interconnections

serial device 1 [serial device 2 [flow control recommended cable
(handshaking)
DTE (Data DTE no handshake [simple null modem cable
Terminal signals
Equipment)
DTE DTE DTE/DCE null modem cable with partial
compatible handshaking
hardware flow
control
DTE DCE (Data no handshake [simple straight cable
Communications|signals
Equipment)
DTE DCE hardware flow [full straight cable
control
DCE IDCE no handshake ([simple null modem cable, but
signals with SUB D9 male connectors on
[both ends
DCE IDCE hardware flow [null modem cable with partial
control handshaking but with SUB D9
male connectors on both ends

SUB D9 Simple Straight Cable
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Area of Application: DTE-DCE Communication where no additional handshake signals are used.

&

I\p rate clive'z hielding ground
/ o

1 i

[
|
I "
I"..}l' 3 50

SUE D9femde SUE 09 mzle

SUB D9 Full Straight Cable

Area of Application;: DTE-DCE Communication with hardware flow control using additional
handshake signals.

&

I\prutecﬁxra@hielding ground /,
(o]
f

SUE D9femde SUE 09 mzle

SUB D9 Simple Null Modem Cable without Handshaking

Area of Application: DTE-DTE Communication where no additional handshake signals are used.

&

I\pr-:lte ctiveszhielding ground

%

f

{
|

L)
I'|Il/l|'

SUE D3femdde SUE D9 femdde

SUB D9 Null Modem Cable with Partial Handshaking

Area of Application: DTE-DTE Communication with DTE/DCE compatible hardware flow control.
Works also when no handshake signals are used.

Copyright 2009 Flachmann und Heggelbacher



Appendix 41

&

I\pr-:lte ctiveszhielding ground

SUE D3femdde SUE D9 femdde

10.5 Docklight Monitoring Cable RS232 SUB D9

Docklight Monitoring Mode requires a full-duplex monitoring cable that feeds the two data
directions into two separate COM ports.

Area of application: Monitoring serial communications between two devices

We offer a custom RS232 cable that is designed for the use with Docklight Monitoring Mode,
according to the cable specification below. Visit our product overview pages for the Docklight
Monitoring Cable, a professional and rugged cable solution for industrial applications.

i

T\prutecﬁxrai’shielding ground ) T
o
J"I <) Device 2
I!I o 1 [ar Full
*> |I[ E £ rmodem
o Z cahle]
| ¥ o
' o * |::>
| J.I =2 4
l
)
i 5
SUE D9 femae SUE 09 male

ok without protective
| shield, if zable length
iz =hort and not used
in EMll polluted area.

S5UE D3femde SUE D3 femdde

Ta Ta
rmonitoring rmonitoring
COM port 1 COMport 2

10.6 Docklight Tap

Docklight Tap is a full-duplex RS232 communications monitoring solution for the USB port.

Area of Application: Monitoring serial communications between two devices

Docklight has built-in support for the Docklight Tap. It recognizes the dual port USB serial
converter and offers high-speed, low-latency access to the monitoring data using the Receive
Channel syntax TAPO, TAPL, ... (see the Docklight Project Settings and How to Obtain Best
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Timing Accuracy for details).

Please see our product overview pages for more information about the Docklight Tap.

Device 1
Sub D9
female

-

Device 2
Sub 09
male

—

B

—

@ (&) ‘J
® ® o
g [ T e

USB Serial
Converter A

LUSB Serial
Converter B

Mini USB [ ]
E 4321
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111

11.2

11.3

114

115

Glossary / Terms Used

Action

For a Receive Sequence, the user may define an action that is performed after receiving the
specified sequence. Possible actions are
e Sending a Send Sequence
Only Send Sequences without any wildcards can be used
¢ Inserting a comment
A user-defined text or an additional date/time stamp is added to the communication data window
and log file

e Triggering a Snapshot
e Stopping communication

Break

A break state on an RS232 connection is characterized by the TX line going to Space (logical 0)
for a longer period than the maximum character frame length including start and stop bits. Some
application protocols, e.g. LIN, use this for synchronization purposes.

CAN

Controller Area Network. A serial bus communication standard originally developed for automotive
applications, but now widely used in many kinds of distributed embedded systems. See also http://
WWwWw.can-cia.org

Character

A character is the basic unit of information processed by Docklight. Docklight always uses 8 bit
characters. Nevertheless, the communication settings also allow data transmission with 7 bits or
less. In this case, only a subset of the 256 possible 8 bit characters will be used but the characters
will still be stored and processed using an 8 bit format.

CRC

Cyclic Redundancy Code. A CRC is a method to detect whether a received sequence/message
has been corrupted, e.g. by transmission errors. This is done by constructing an additional
checksum value that is a function of the message data, and then appending this value to the
original message. The receiver calculates the checksum from the received data and compares it to
the transmitted CRC value to see if the message is unmodified. CRCs are commonly used
because they allow the detection of typical transmission errors (bit errors, burst errors) with a very
high accuracy.

CRC algorithms are based on polynomial arithmetic, and come in many different versions.
Common algorithms are CRC-CCITT, CRC-16 and CRC-32. An example of an application
protocol that uses a CRC is MODBUS over Serial Line.

A very popular article about CRCs is "Easier said than done (Michael Barr) - A guide to CRC
calculation™: http://www.netrino.com/Connecting/2000-01/

Docklight Scripting's CRC functionality (DL.CalcChecksum) was inspired by the above article and
the proposed Boost CRC library:
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http://www.boost.org/libs/crc/index.html

Last not least, if you are truly fascinated by CRC alchemy, you will, sooner or later, run into the
following article:

"A Painless Guide to CRC Error Detection Algorithms" by Ross N. Williams
http://www.ross.net/crc/

DCE

Data Communications Equipment. The terms DCE and DTE refer to the serial devices on each
side of an RS232 link. A modem is a typical example of a DCE device. DCE are normally equipped
with a female SUB D9 or SUB D25 connector. See also DTE.

DTE

Data Terminal Equipment. The terms DCE and DTE refer to the serial devices on each side of an
RS232 link. A PC or a terminal are examples of a typical DTE device. DTE are commonly
equipped with a male SUB D9 or SUB D25 connector. All pinout specifications are written from a
DTE perspective. See also DCE.

Flow Control

Flow control provides a mechanism for suspending transmission while one device is busy or for
some reason cannot further communicate. The DTE and DCE must agree on the flow control
mechanism used for a communication session. There are two types of flow control: hardware and
software.

Hardware Flow Control
Uses voltage signals on the RS232 status lines RTS / DTR (set by DTE) and CTS / DSR (set by
DCE) to control the transmission and reception of data. See also RS232 pinout.

Software Flow Control

Uses dedicated ASCII control characters (XON / XOFF) to control data transmission. Software
flow control requires text-based communication data or other data that does not contain any XON
or XOFF characters.

LIN

Local Interconnect Network. A low cost serial communication bus targeted at distributed electronic
systems in vehicles, especially simple components like door motors, steering wheel controls,
climate sensors, etc. See also http://www.lin-subbus.org

MODBUS

MODBUS is an application layer messaging protocol that provides client/server communications
between devices connected on different types of buses or networks. It is commonly used as
"MODBUS over Serial Line" in RS422/485 networks, but can be implemented using TCP over
Ethernet as well ("MODBUS TCP").

Two different serial transmission modes for MODBUS are defined: "RTU mode" for 8 bit binary
transmissions, and "ASCIlI mode". "RTU mode" is the default mode that must be implemented by
all devices.
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See http://www.modbus.org for a complete specification of the MODBUS protocol.

11.11 Receive Sequence

A Receive Sequence is a sequence that can be detected by Docklight within the incoming serial
data. A Receive Sequence is specified by

1. an unique name (e.g. "Modem Answer OK"),

2. a character sequence (e.g. "6F 6B 13 10" in HEX format),

3. an action that is triggered when Docklight receives the defined sequence.

11.12 RS232

The RS232 standard is defined by the EIA/TIA (Electronic Industries Alliance /
Telecommunications Industry Associations). The standard defines an asynchronous serial data
transfer mechanism, as well as the physical and electrical characteristics of the interface.

RS232 uses serial bit streams transmitted at a predefined baud rate. The information is separated
into characters of 5 to 8 bits lengths. Additional start and stop bits are used for synchronization,
and a parity bit may be included to provide a simple error detection mechanism.

The electrical interface includes unbalanced line drivers, i.e. all signals are represented by a
voltage with reference to a common signal ground. RS232 defines two states for the data signals:
mark state (or logical 1) and space state (or logical 0). The range of voltages for representing
these states is specified as follows:

Signal State Transmitter Voltage |Receiver Voltage
Range Range

Mark (logical 1) -15V to -5V -25V to -3V

Space (logical 0) +5V to +15V +3V to +25V

Undefined -5V to +5V -3V to +3V

The physical characteristics of the RS232 standard are described in the section RS232
Connectors / Pinout

11.13 RS422

An RS422 communication link is a four-wire link with balanced line drivers. In a balanced
differential system, one signal is transmitted using two wires (A and B). The signal state is
represented by the voltage across the two wires. Although a common signal ground connection is
necessary, it is not used to determine the signal state at the receiver. This results in a high
immunity against EMI (electromagnetic interference) and allows cable lengths of over 1000m,
depending on the cable type and baud rate.

The EIA Standard RS422-A "Electrical characteristics of balanced voltage digital interface circuits"
defines the characteristics of an RS422 interface.

Transmitter and receiver characteristics according to RS422-A are:

Signal State Transmitter Differential |Receiver Differential Voltage
\Voltage Vas \/AB

Mark (or logical 1) -6V to -2V -6V to -200mV

Space (or logical 0) [+2V to +6V +200mV to 6V

Undefined -2V to +2V -200mV to +200mV
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Permitted Common Mode Voltage Vcm (mean voltage of A and B terminals with reference to signal
ground): -7V to +7V

11.14 RS485

The RS485 standard defines a balanced two-wire transmission line, which may be shared as a bus

line by up to 32 driver/receiver pairs. Many characteristics of the transmitters and receivers are the

same as RS422. The main differences between RS422 and RS485 are

e Two-wire (half duplex) transmission instead of four-wire transmission

e Balanced line drivers with tristate capability. The RS485 line driver has an additional "enable”
signal which is used to connect and disconnect the driver to its output terminal. The term
"tristate" refers to the three different states possible at the output terminal: mark (logical 1),
space (logical 0) or "disconnected"

e Extended Common Mode Voltage (Vem) range from -7V to +12V.

The EIA Standard RS485 "Standard for electrical characteristics of generators and receivers for
use in balanced digital multipoint systems" defines the characteristics of an RS485 system.

11.15 Send Sequence

A Send Sequence is a sequence that can be sent by Docklight. A Send Sequence is specified by
1. an unique name (e.g. "Set modem speaker volume"),
2. a character sequence (e.g. "41 54 4C 0D 0A" in HEX format).

There are two ways to make Docklight send a sequence:

e Sending a sequence can be triggered manually by pressing the send button in the Send
Sequences list
(see Main Window).

e Sending a sequence may be one possible reaction when Docklight detects a specific Receive
Sequence within the incoming data (see Action).

11.16 Sequence

A sequence consists of one or more 8 bit characters. A sequence can be any part of the serial
communications you are analyzing. It can consist of printable ASCII characters, but may also
include every non-printable character between 0 and 255 decimal.

Example:

ATL2 (ASCII format)

41 54 4C 0D 0A (HEX format)

This sequence is a modem command to set the speaker volume on AT compatible modems. It
includes a Carriage Return (0D) and a Line Feed (0A) character at the end of the line.

The maximum sequence size in Docklight is 1024 characters.

11.17 Sequence Index

The Sequence Index is the element number of a Send Sequence within the Send Sequence List,
or of a Receive Sequence within the Receive Sequence List. The Sequence Index is displayed in
the upper left corner of the Edit Send Sequence or Edit Receive Sequence dialog.
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11.18

11.19

11.20

11.21

11.22

Serial Device Server

A Serial Device Server is a network device that offers one or more serial COM ports (RS232,
RS422/485) and transmits/receives the serial data over an Ethernet network. Serial Device
Servers are a common way for upgrading existing devices that are controlled via serial port and
make them "network-enabled".

Snapshot

Creating a snapshot in Docklight means generating a display of the serial communication shortly
before and after a Trigger sequence has been detected. This is useful when testing for a rare error
which is characterized by a specific sequence. See Catching a specific sequence and taking a
snapshot... for more information.

Trigger

A Trigger is a Receive Sequence with the "Trigger" option enabled (see Dialog: Edit Receive
Sequence). When the Snapshot function is enabled, Docklight will not produce any output until a
trigger sequence has been detected in the serial communication data. See Catching a specific
seguence and taking a snapshot... for more information.

UART

Universal Asynchronous Receiver / Transmitter. The UART is the hardware component that
performs the main serial communications tasks:

- converting characters into a serial bit stream

- adding start / stop / parity bits, and checking for parity errors on the receiver side

- all tasks related to timing, baud rates and synchronization

Common UARTSs are compatible with the 16550A UART. They include a 16 byte buffer for
incoming data (RX FiFo), and a 16 byte buffer for outgoing data (TX FiFo). Usually these buffers
can be disabled/enabled using the Windows Device Manager and opening the property page for
the appropriate COM port (e.g. COM1).

Virtual Null Modem

A virtual null modem is a PC software driver which emulates two serial COM ports that are
connected by a null modem cable. If one PC application sends data on one virtual COM port, a
second PC application can receive this data on the second virtual COM port and vice versa.

By using a virtual null modem driver on your PC you can easily debug and simulate serial data
connections without the use of real RS232 ports and cables.

Virtual COM connections do not give you the same timing as real RS232 connections and usually
do not emulate the actual bit-by-bit transmission using a predefined baud rate. Any data packet
sent on the first COM port will appear in the second COM port's receive buffer almost immediately.
For most debugging and simulation purposes this limitation can be easily tolerated. Some virtual
null modem drivers offer an additional baud rate emulation mode, where the data transfer is
delayed to emulate a real RS232 connection and its limited transmission rate.

For an Open Source Windows software that has been successfully tested with Docklight, see
http://comOcom.sourceforge.net/
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11.23 Wildcard

A wildcard is a special character that serves as a placeholder within a sequence. It may be used
for Receive Sequences when parts of the received data are unspecified, e.g. measurement
readings reported by a serial device. Wildcards can also be used to support parameters in a Send

Sequence.

Two types of wildcards are available in Docklight:

Wildcard '?' : Matches exactly one arbitrary character (any ASCII code between 0 and 255)
Wildcard '#' : Matches zero or one character. This is useful for supporting variable length
command arguments (e.g. a status word) in Send / Receive Sequences. See Checking for
sequences with random characters or Sending commands with parameters for examples and
additional information.
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